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PSoC®1 入门
作者：Robert Murphy、Ashutosh Srivastava
相关项目：有
相关器件系列：所有 PSoC 1 系列
软件版本：PSoC Designer™ 5.4 SP 1 及更高版本
相关应用手册：要想获取完整的应用笔记列表，请点击此处。
如果需要获取此应用笔记的最新版本或示例项目文件，请点击此处。
AN75320 向您介绍了 PSoC ® 1，它是一个带有可编程数字和模拟模块的 8 位处理程序器，能够完成客户自定义功
能。该应用笔记说明了 PSoC 1 架构和开发工具，并介绍如何创建您的第一个设计。此外，本应用笔记还向您提供了更
多的资源，用以加快深入学习有关 PSoC 1 的知识。
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1
简介
PSoC 1 是真正的可编程嵌入式片上系统，在同一芯片中集成了自定义的模拟和数字外设功能、存储器以及 M8C 微控
制器。
这样的系统和大部分混合信号嵌入式系统不完全一样，它们使用了一个微控制器（MCU）和外部模拟和数字外设的组
合。除 MCU 外，通常它还需要多个集成电路，如运算放大器、模数转换器（ADC）和数字 ASIC。
PSoC 1 提供了一个低成本的备用方案，该方案可以替代一般的 MCU 加外部集成电路（IC）的组合方案。它的可编程
模拟和数字子系统不仅可以降低整个系统成本，而且还支持极为灵活地调整设计，使产品快速上市。
在运行时，PSoC 1 的系统资源可以进行动态重配置，以便完整实现其他功能。如果资源在设计中已被占用，那么可以
执行动态重配置。这使您能够重新使用 PSoC 1 系统资源并最大化集成价值主张。
PSoC 1 中的电容式触摸感应特性，称为 CapSense®，能提供前所未有的信噪比（SNR）、一流的防水性能以及支持
各种类型的传感器，如按键、滑条、触控板和接近传感器。
该应用笔记帮助您了解 PSoC 1 架构和开发工具，并且介绍如何使用 PSoC Designer™（PSoC 1 的开发工具）来构建
您的第一个项目。此外，本应用笔记还向您提供了更多的资源，用以加快深入学习有关 PSoC 1 的知识。
除 PSoC 1 外，赛普拉斯 PSoC 系列还包括 PSoC 3、PSoC 4 和 PSoC 5LP 器件。这些 PSoC 器件提供了不同的系统
架构和外设。更多有关信息，请参见赛普拉斯平台 PSoC 解决方案路线图。
2
入门
赛普拉斯的网站 www.cypress.com 上提供了大量数据，有助于正确选择您设计的 PSoC 器件，并使您能够快速和有效
地将器件集成到设计中。有关使用资源的完整列表，请参考知识库文章“如何使用 PSoC® 1、PowerPSoC®和 PLC 进
行设计 — KBA88292”。下面是 PSoC 1 的简要列表：




概况：PSoC 产品系列、PSoC 路线图
产品选型：PSoC 1、PSoC 3、PSoC 4、PSoC 5LP
此外，PSoC Designer 还包含了一个器件选择工具
应用笔记：赛普拉斯提供了大量 PSoC 应用笔记，包括从基本到高级的广泛主题。下面列出了 PSoC 1 入门的应用
笔记：





AN75320 — PSoC® 1 入门。
AN2094 — PSoC® 1 — GPIO 入门。
AN74170 — PSoC® 1 模拟结构和配置
AN2041 — PSoC® 1 开关电容模拟模块。
AN2219 — 选择模拟接地和参考电压
注意：欲了解与本应用笔记相关的 CY8C29X66 器件，请点击此处。

开发套件：

除了 CY8C25/26xxx 器件外，CY3210-PSoCEval1 支持所有 PSoC 1 混合信号阵列系列（包括汽车级器
件）。该套件包括 LCD 模块、电位器、LED 和实验板空间。

CY3214-PSoCEvalUSB 主要作为 CY8C24x94 PSoC 器件的开发板使用。开发板的特殊功能包括 USB 和
CapSense 开发和调试支持。
注意：欲了解与开发套件相关的 CY8C29X66 器件，请点击此处。
MiniProg1 和 MiniProg3 器件提供了用于进行闪存编程和调试的接口。
www.cypress.com
文档编号：001-78863 版本*E
2
================
®
PSoC 1 入门
________________________________________________________________________________________________________________
2.1
PSoC Designer
PSoC Designer 是免费的基于 Windows 的集成设计环境（IDE）。在拖放式设计环境中使用预先设定的模拟和数字外
设库来开发您的应用程序。然后，利用动态生成的 API 代码库来自定义您的设计。图 1 显示的是 PSoC Designer 窗
口。注意：这并不是默认窗口。
1.
Global Resources（全局资源） — 所有器件硬件的设置。
2.
Parameters（参数）— 当前选中的用户模块的参数。
3.
Pinout（引脚分布）— 器件引脚的相关信息。
4.
Chip-Level Editor（芯片级编辑器）— 选中芯片上可用资源的框图。
5.
Datasheet（数据手册）— 当前选中的用户模块的数据手册。
6.
User Modules（用户模块）— 选中器件的所有可用的用户模块。
7.
Device Resource Meter（器件资源计）— 当前项目配置的器件资源使用率。
8.
Workspace（工作区）— 与项目有关的文件树级图。
9.
Output（输出）— 从项目构建和调试操作的输出。
注意：欲了解有关 PSoC Designer 的详细信息，请打开 PSoC Designer IDE，依次选择 Help > Documentation，
然后打开“Designer Specific Documents”文件夹，再打开“IDE User Guide.pdf”文档。
图 1. PSoC Designer 布局
www.cypress.com
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2.2
代码示例
下面的网页列出了基于 PSoC Designer 的代码示例。这些代码示例通过向您提供一个完整的设计（而不是空白设计）
加快您的程序设计，并显示了如何将 PSoC Designer 用户模块用于各种应用。
http://www.cypress.com/documentation/code-examples/psoc-1-code-examples
要想访问集成在 PSoC Designer 中的代码示例，请依次选择 Start Page > Design Catalog > Launch Example
Browser，如图 2 所示。
图 2. PSoC Designer 中的代码示例
在图 3 中显示的示例项目浏览器内，您可以选择以下选项。





通过关键词搜索筛选项目。
根据类别列出项目。
（在 Description（说明）选项卡上）查看已选项目的数据手册。
查看已选项目的代码示例。您可以复制该窗口中的代码然后将其粘贴在您的项目内，从而加快代码的开发过程或
根据已选项目创建一个新的项目（若需要可添加新的工作区）。通过向您提供一个完整的基本设计它可以加快您的
设计程序。然后，您可以根据自己的应用更改该设计。
www.cypress.com
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图 3. 附带代码的示例工程
2.3
PSoC Designer 帮助
请访问 PSoC Designer 主页以下载 PSoC Designer 的最新版本。然后，启动 PSoC Designer 并导航到以下各项：
2.4

IDE 用户指南：依次选择 Help（帮助） > Documentation（文档） > Designer Specific Documents
（Designer 专用文档） > IDE User Guide.pdf （IDE 用户指南）。本指南提供了开发 PSoC Creator 项目的基本
知识。

简单用户模块代码示例：依次选择 Start Page（起始页） > Design Catalog（设计目录） > Launch Example
Browser（启动示例浏览器）。这些代码示例显示了如何配置和使用 PSoC Designer 用户模块。

技术参考手册：依次选择 Help（帮助） > Documentation（文档） > Technical Reference Manuals（技术参
考手册）。该指南列出并描述了 PSoC 器件的系统功能。

用户模块数据手册：右击用户模块并选择“Datasheet”（数据手册）。该数据手册说明了已选用户模块中的各参
数和 API。

器件数据手册：依次选择 Help（帮助） > Documentation（文档） > Device Datasheets（器件数据手册），
从而获得特殊 PSoC 器件的数据手册。

Imagecraft 编译器指南：依次选择 Help（帮助） > Documentation（文档） > Compiler and Programming
Documents（编译器和编程文档） > C Language Compiler User Guide.pdf （C 语言编译器用户指南）。
该指南提供了 Imagecraft 编译器特殊指令和函数的详细信息。
技术支持
若有任何疑问，我们的技术支持团队很乐意为您提供帮助。您可以在赛普拉斯技术支持页面上创建一项支持请求。
如果您在美国，可以通过拨打我们的免费电话，直接与技术支持团队取得联系：+1-800-541-4736。选择提示符处的
第 8 项。
www.cypress.com
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若想快速获得支持，您同样可以使用下面的支持资源。


自助
所在地销售办事处
PSoC 1 系列的比较
3
PSoC 1 包括 13 个器件系列。表 1 显示的是这些器件具有的特性。
表 1. PSoC 1 器件选型汇总表
器件系列
特性
29x66
28xxx
27x43
24x94
24x93
24x33
24x23A
23x33
22x45
21x45
21x34
21x23
32K
16 K
16 K
16 K
32K
8K
4K
8K
16 K
8K
8K
4K
2K
1K
256B
512B
2K
256B
256B
256B
1K
512B
512B
256B
14 位
（DS）
4x14 位
（DS）
11 位
（DS）
14 位
（DS）
10 位
11 位
（DS）
11 位
8位
（DS）
11 位
（DS）
8位
（INC）
（SS）
（SS）
10 位
（SS）
10 位
（SS）
10 位
（150
Ksps）
8位
10 位
10 位
-
-
-
-
（300
Ksps）
-
（300
Ksps）
（150
Ksps）
（150
Ksps）
-
-
4
4
4
2
2
2
2
2
4
4
2
2
4
4
4
2
-
2
2
2
-
-
-
-
4
4
4
2
-
2
2
2
-
-
-
-
8
6
4
2
2
2
2
4
2
2
2
UART/SPI
4
3
2
1
1
1
1
2
1
1
1
I2C
1
2
1
1
1
1
1
1
1
1
1
CapSense
按键
-
43
-
49
-
-
-
-
37
23
23
-
GPIO
64
44
44
50
36
26
24
26
38
24
24
16
USB
-
-
-
FS 2.0
FS 2.0
-
-
-
-
-
-
-
ECO
有
有
有
无
有
有
有
有
有
有
无
无
SMP
有
有
有
无
无
无
有
无
有
有
有
有
MAC
2
2
1
2
0
1
1
1
1
1
0
0
闪存
（KB）
SRAM
（KB）
ADC 1
（DS/SS）
ADC 2
（SAR）
电压比较器
DAC
（8 位）
PGA
（x48 增益）
TCPWM
（16 位）
8位
3
（定时器）
1 SPI
1
（从设备）
FS = 全速、SMP = 开关电压泵、ECO = 外部晶体振荡器、MAC = 乘法累加器、 INC = 递增、PGA = 可编程增益放大器、TCPWM = 定时器计数器脉冲宽度调制器、
UART = 通用异步接收器/发送器、SPI = 串行外设接口、I2C = 内部集成电路
www.cypress.com
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4
PSoC 1 特性集
PSoC 1 具有一系列强大的功能和特性，包括：一个 CPU 内核和存储器子系统、一个数字子系统、一个模拟子系统、
一个存储器系统以及系统资源，如图 4 所示。下面各节对每个特性进行了简要说明。更多有关信息，请查看 PSoC 1 的
参考资源一节中所列出的 PSoC 1 系列器件的数据手册、技术参考手册（TRM）以及应用笔记。
图 4. PSoC 1 架构（CY8C29466）
Port 7
Port 6
Port 5
Port 4
Port 3
Port 2
Port 1
Port 0
Analog
Drivers
SYSTEM BUS
Global Digital Interconnect
Global Analog Interconnect
PSoC CORE
Supervisory ROM (SROM)
SRAM
Flash Nonvolatile Memory
CPU Core (M8C)
Interrupt
Controller
24 MHz Internal Main
Oscillator (IMO)
Internal Low Speed
Oscillator (ILO)
Sleep and
Watchdog
Phase Locked
Loop (PLL)
32 KHz Crystal
Oscillator (ECO)
Multiple Clock Sources
DIGITAL SYSTEM
ANALOG SYSTEM
Digital PSoC Block Array
Analog
Ref
Analog PSoC
Block Array
DBB00
DBB01
DCB02
DCB03
DBB10
DBB11
DCB12
DCB13
CT
CT
CT
CT
DBB20
DBB21
DCB22
DCB23
SC
SC
SC
SC
SC
SC
SC
SC
DBB30
DBB31
DCB32
DCB33
1 to 4 Digital Rows
Analog
Input
Muxing
1 to 4 Analog Columns
SYSTEM BUS
Digital
Clocks
Multiply
Accumulate
(MACs)
POR and LVD
Decimators
I2C
System Resets
Switch
Mode
Pump
Internal
Voltage
Reference
USB
IO Analog
Multiplexer
SYSTEM RESOURCES
图 4 显示的是 CY8C29466 器件系列的各项特性。对于其他器件系列具备的这些特性的子集，请参考表 1。
www.cypress.com
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4.1
M8C 处理器和储存器
PSoC 1 具有一个 M8C 处理器，该处理器是一个带有哈佛架构的 8 位 RISC CPU。它的最大工作频率为 24 MHz，并提
供了 4 MIPS 的性能。M8C 具有 37 条指令。PSoC 1 器件具有 2 KB 的 SRAM 和 32 KB 的闪存，如表 1 所示。有关详
细信息，请参见 PSoC 1 技术参考手册。
4.2
可编程数字子系统
PSoC 的数字子系统是独一无二的，因为它具有性能优异的可编程性和灵活布线系统。表 1 列出了每个器件可用的各种
PSoC 1 器件以及数字资源。PSoC 1 中的数字模块分为两种类型：数字基本模块（DBB）和数字通信模块（DCB）。
DBB 和 DCB 的数量始终是相等的。
4.2.1
数字基本模块（DBB）
DBB 是可配置的基本数字资源，您可将其配置为定时器、计数器或脉冲宽度调制器（PWM）。每个 DBB 中均可放置
一个 8 位的数字资源。创建 16 位、24 位或 32 位数字资源分别需要 2 个、3 个或 4 个数字模块。
4.2.2
数字通信模块（DCB）
DCB 不仅能够放置基本数字资源（定时器、计数器或 PWM），还可以用来放置数字通信资源，例如 SPI 和 UART。
您也可以在 DCB 中放置 DBB。不过，您不能将 DCB 资源放置于 DBB。
4.3
可编程模拟子系统
PSoC 1 的独特模拟由采用列配置分布的模拟模块组成。这些模拟模块均为连续时间（CT）模块或开关电容（CT）
模块。
4.3.1
连续时间（CT）模块
PSoC 内部的连续时间（CT）模块是可编程模拟模块，用户可将其配置为比较器或可编程增益放大器（PGA）。CT 模
块围绕着低噪声和低偏移的运算放大器来构建。CT 模块中的大多数模拟复用器提供了高度可配置性。有关连续时间模
块结构和组成的更多信息，请参阅 PSoC 1 技术参考手册的第 22 章。
4.3.2
开关电容（SC）模块
SC 模块围绕着低噪声和低偏移的运算放大器来构建，并被多个模拟复用器环绕。这些模块极为特别，因为其周围的运
算放大器和复用器均是电容组和开关组。与 CT 模块不同，开关电容模块中没有电阻阵列。有关 SC 模块结构的更多信
息，请参阅 PSoC 1 技术参考手册的第 23 章或 AN2041 — 了解 PSoC 1 开关电容模拟模块。
4.4
系统范围资源
4.4.1
时钟系统
PSoC 具有一个高级的时钟系统，系统含有多个时钟源，许多时钟源均可进行编程。从内部 24 MHz 主振荡器（IMO）
或最高 24 MHz 的外部时钟中提取主时钟源。此外，对于低速振荡器，可以使用 32 kHz 的外部振荡器电路或内部低速
振荡器（ILO）。有关 PSoC 1 可用时钟的详细信息，请参考 AN32200 — PSoC® 1 — 时钟和全局资源。
4.4.2
开关电压泵（SMP）
开关电压泵（SMP）是一种受 PSoC 支持的 DC/DC 升压电路，通过它，器件将可以由单节 1.5 V 电池供电运转。
PSoC 含有一个内置的 FET 和独立的 PWM 硬件，以实现升压。您只需提供一节外部电池、一个电感、一只二极管和
一个电容便完成升压电路。更多详细信息，请参考 PSoC 1 技术参考手册中第 30 章的内容。
www.cypress.com
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4.4.3
乘 法 累 加 器 （ M AC ）
乘法累加器，即 MAC，能够提供一个 8 位有符号数乘数器，以及用于对数字求和的 32 位累加器。在进行数学运算和
实现数字滤波器时，MAC 极为有用。您可以通过向器件中的特定寄存器写入或读取数据来使用 MAC。在完成乘运算
后，您可以从寄存器中读出数值或将值存储在累加器中。通过向清零寄存器（MACx_CL1 和 MACx_CL2）写数据，可
以清空累加器并将其复位至零。更多详细信息，请参考 PSoC 1 技术参考手册中第 26 章的内容。
4.4.4
电压参考
PSoC 1 中有许多参考电压的选项。其中最重要的三个术语分别为：
1.
AGND
2.
RefHi
3.
RefLo
器件中模拟信号的电压均以模拟地（AGND）为参考地。AGND 的电压值有多种选项，具体数值由开发人员决定。高于
AGND 的模拟信号被视为正，而低于 AGND 的电压则被视为负。RefHi 和 RefLo 指模拟系统的电压上限和下限。更多
详细信息，请参考 AN2219 — PSoC® 1 选择模拟接地和参考电压。
4.4.5
I2C 专用硬件
I2C 通信模块是一种串行转并行的处理器，用于将 PSoC 器件连接至 I2C 两线串行通信总线。为消除的 M8C 微控制器
过多干预和开销，该硬件控制器支持针对 I2C 的状态检测和分割位生成功能。
以下为 PSoC I2C 硬件控制器的主要特性和功能：





行业标准 Philips® I2C 总线兼容接口
主设备和从设备操作，可实现多主设备操作
只有两个引脚（SDA 和 SCL）需要与 I2C 总线连接
标准数据速率为 100/400 kbps，同时支持 50 kbps
7 位寻址模式，支持 10 位寻址
有关使用 I2C 的更多信息，请参见 AN50987：PSoC 1 I2C 入门。
4.5
GPIO 系统
GPIO 系统提供了 CPU 与外设以及外界相互间的接口。在用作数字 I/O 时，每个 GPIO 可以支持 10 mA 的拉电流和
25 mA 的灌电流。器件总共可以支持 200 mA 的灌电流，每侧 100 mA。因此，任意端口上的偶数引脚都能够支持共计
100 mA 的灌电流，所有奇数引脚也可以支持 100 mA 的灌电流。此外，器件可以支持共计 80 mA 的源电流，每侧
®
40 mA。有关详细信息，请参见 PSoC 1 技术参考手册中的第 6 章和 AN2094 — PSoC 1 —GPIO 入门的内容。
4.6
CapSense
某些 PSoC 1 器件还支持一种电容式触摸传感方法，即为 CapSense。电容触摸传感器是用户接口设备，通过检测人体
的电容变化可检测（接近）传感器周围是否存在手指。电容传感器有出色的外观，容易使用且使用寿命长。使用
CapSense，您可以利用作为 PCB 上简单铜走线的电容式感应按键替代价格昂贵但性能却不可靠的机械按键。
CapSense 支持各种传感器，如：按键、滑条、触摸板以及接近传感器。请参考表 1 以了解 PSoC 1 器件如何支持
CapSense。更多详细信息，请参见 AN64846 —CapSense 入门中的内容。
www.cypress.com
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4.7
动态重配置
对于 PSoC 1，用户可以直接开始设计，而无需要先了解终端产品，然后根据需要添加资源。只要用户有可用的数字或
模拟资源，便可以随时对设计进行调整、修改和扩展。即使在设计中资源已被占用，PSoC 也可在运行时进行动态重配
置 ，以实现其 他功能。这使 您能够重新使 用 PSoC 中 的资源并最大 化集成价值主 张。更多详细 信息，请参考
AN2104 — PSoC®1 — 使用 PSoC® Designer™进行动态重配置。
5
开发工具
赛普拉斯的高质量的开发工具（例如：PSoC Designer 软件工具和包含开发套件、编程硬件、调试硬件的硬件工具）
对 PSoC 1 提供了支持。使用这些工具，用户便可以配置器件、开发应用代码、构建、调试并实施嵌入式设计。
5.1
软件：PSoC Designer 集成开发环境
赛普拉斯 PSoC Designer 是一个集成开发环境（IDE），用于对 PSoC 1 器件进行定制、配置和编程。您可以从
http://www.cypress.com/go/psocdesigner 网站下载该工具。
PSoC Designer 开发环境功能齐全，您可以在其中配置模拟和数字外设、编写应用代码，并执行本应用笔记中所述的
功能，从而创建您自己的 PSoC 应用。此外，您可使用本软件在 PSoC ICE-Cube 调试平台对 PSoC 器件进行编程和调
试。
图 5 显示了 PSoC Designer 的布局以及 PSoC Designer 章节中所介绍的 IDE 的各个部分的内容。请注意，这并不是
PSoC Designer 的 默 认 布 局 。 如 果 以 下 描 述 的 任 何 窗 口 在 您 打 开 Designer 时 并 未 出 现 ， 均 可 在 工 具 栏 中 的
View（查看）下拉菜单中进行添加。
图 5. PSoC Designer 布局
5.2
硬件
赛普拉斯提供了各种 PSoC 1 硬件套件，以满足您的设计要求。要想选择您的 PSoC 1 器件，请参考 PSoC 1 套件和
PSoC 1 套件选择器指南中介绍的内容。以下部分将会提供开发套件、编程硬件和调试硬件的列表。
www.cypress.com
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5.2.1
开发套件
通过赛普拉斯的开发工具，您可轻松构建自己的 PSoC 1 设计原型。表 2 列出了各开发套件，这些开发套件支持
PSoC 1 的评估。请参考开发套件以获取开发套件/板的完整列表。
表 2. PSoC 1 开发套件
开发套件
5.2.2
说明
CY3210PSOCEVAL1
通过 CY3210 PSoC Eval1 套件，您可以评估和体验赛普拉斯 PSoC 1 可编程片上系统的设计方法和架
构。
CY8CKIT-001
CY8CKIT-001 PSoC 开发套件提供一个通用的开发平台，以供用户实现和评估不同的解决方案原型。
硬件编程器
您可以从赛普拉斯所提供的工具以及第三方工具为编程器件选择一些选项。赛普拉斯提供了四种编程器件：
MiniProg1、MiniProg3、ICE-Cube 和 CY3207-ISSP。
MiniProg1
MiniProg1 是 ISSP 编程器，许多 PSoC 1 开发套件均包含此编程器。除 CY25/26xxx 器件以外，其他的 PSoC 1 器件
均可使用此编程器。MiniProg1 不可以用来对 PSoC 3 或 PSoC 5 器件进行编程。
MiniProg3
MiniProg3 是 ISSP 编程器，包含在 CY8CKIT-001 开发套件中。MiniProg3 是针对 PSoC 1、PSoC 3 和 PSoC 5 器件
的一体化编程器，也是针对 PSoC 3 和 PSoC 5 架构的调试工具，同时也是用于调试 I2C 串行连接和与 PSoC 器件进行
通信的 USB-I2C 桥接器。
第三方编程器
请访问 http://www.cypress.com/documentation/development-kitsboards/general-psoc-programming 网站以便查看第
三方编程器工具的列表。这些工具均由赛普拉斯进行设计、测试和认证，用于支持 PSoC 1 器件的编程。
5.2.3
调试硬件
CY3215A-DK
CY3215A-DK 在线仿真器 Lite 开发套件包括一个在线仿真器（ICE）。ICE-Cube 主要用于调试 PSoC 1 器件，但它也
可使用 ISSP 对 PSoC 1 器件进行编程。您可以直接使用 ISSP 黄色线缆为器件编程，而无需用 CAT5 蓝色线缆或柔性
线缆与调试转接板连接。因此，在调试和生产环境中，ICE-Cube 均适用。更多详细信息，请查看 AN73212 — 使用
PSoC 1 进行调试。
6
PSoC 1 的参考资源
本节介绍了 PSoC 1 的参考资源列表，根据该列表您可开始并深入开发 PSoC 1 的应用。PSoC 1 开发人员可以获取多
种可用资源，包括数据手册、参考手册、视频和应用笔记。
6.1
PSoC 1 数据手册
请访问 PSoC 1 数据手册网页以查看 PSoC 1 数据手册，该数据手册将列出所有 PSoC 1 器件系列中的各项特性以及电
气规范。
www.cypress.com
文档编号：001-78863 版本*E
11
================
®
PSoC 1 入门
_________________________________________________________________________________________________________________
6.2
参考 PSoC 1 Designer
请访问 PSoC Designer 主页以下载 PSoC Designer 的最新版本。
启动 PSoC Designer，然后逐步执行以下各项：
PSoC Designer 用户指南：访问 PSoC Designer 用户指南网页以便查看 PSoC Designer 用户指南。
6.2.1
IDE 用户指南
Launch PSoC Designer（启动 PSoC Designer） > Help（帮助） > Documentation（文档） > Designer Specific
Documents（Designer 专用文档） > IDE User Guide（IDE 用户指南）。本指南提供了开发 PSoC Designer 项目的
基本知识。
6.2.2
示例项目
Launch PSoC Designer（启动 PSoC Designer） > Design Catalog （设计目录）> Example projects（示例项
目）。这些示例项目展示了如何配置及使用 PSoC Designer 组件。
6.2.3
PSoC Designer 培训
这些培训将帮助您设计和展示介绍 PSoC Designer、动态重配置以及使用 PSoC 进行调试。
6.2.4
组件数据手册：
Launch PSoC Designer（启动 PSoC Designer） > Workspace Explorer（工作区浏览器）。在 Chip 选项卡下面，
右击某个组件并选择 Datasheet（数据手册）。
6.3
应用笔记
通过各应用笔记，您可以了解器件的具体功能并设计您的 PSoC 1 应用。请访问 PSoC 1 应用笔记网页以获取 PSoC 1
应用笔记的完成列表。
6.4
知识库文章
这是包含了常见技术支持问题及其相关解答的数据库。请访问知识库文章网页以获取 PSoC 1 知识库网页的完整列表。
6.5
技术参考手册（TRM）
技术参考手册（TRM）提供了 PSoC 1 器件的内部架构的详细说明。要想获取 PSoC 1 技术参考手册列表，请访问
PSoC 1 技术参考手册网页。
6.6
器件勘误表
这些文件列出了与器件数据手册或技术参考手册内容不符的器件规范。请访问器件勘误表网页以便获取器件勘误表文件
的列表。
6.7
技术支持
若有任何疑问，我们的技术支持团队很乐意为您提供帮助。您可以通过赛普拉斯技术支持连接发送支持请求。
若果您是在美国，则可以拨打我们以下免费电话，直接与技术支持团队联系：+1-800-541-4736。选择提示符处的
第 8 项。
若想获得快速支持，您同样也可以使用下面的支持资源：


自助
所在地销售办事处
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7
我的第一个 PSoC 1 设计
本节介绍了使用 PSoC Designer 构建 PSoC 1，然后将其编程为 PSoC 器件并将 PSoC 1 展示板配置以便查看结果的
简单设计流程。
7.1
设计概况
使用该设计构建一个简单项目，该项目会在两个 GPIO 上产生两个 PWM 输出（一个使用硬件资源，另一个使用软件资
源）。一个 GPIO 驱动 LED 进行固定频率闪烁，另一个 GPIO 则驱动 LED 进行心跳式的闪烁（渐亮渐灭）。该项目还
可以使用 ADC 用户模块来测量模拟电压。
7.2
创建我的第一个 PSoC 1 设计
7.2.1
创建项目
首先，您可以在 PSoC Designer 中创建一个项目。在此处，您先选定器件，然后将开发语言设置为 C 语言。该示例项
目采用 CY8C29466-24PXI，因为它是附随 CY3210-PSoCEval1 套件的器件。
1.
在 PSoC Designer 中，请选择 File（文件） > New Project（新项目）并将其命名为 AN75320，如图 6 所示。
图 6. 创建一个新的 PSoC Designer 项目
2.
点击 Device Catalog（器件目录）以选择器件，如图 7 所示。
图 7. 器件目录
www.cypress.com
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注意：如果您要使用其他工具包开发此例程，则应使用以下器件型号：


CY3214-PSoCEvalUSB：CY8C24994-24LTXI
3.
点击 Create Project with ‘CY8C29466-24PXI’（使用‘CY8C29466-24PXI’创建项目），然后点击 OK。
CY3271-PSoC First Touch：CY8C20634-12FDXI
此时，将打开项目工作区，并显示 Chip Editor（芯片编辑器）和 Workspace Explorer（工作区浏览器）。按下 Ctrl 并
点击以放大 Chip Editor 视图，显示出选定器件的模块框图。
7.2.2
选择用户模块
在该步骤中，您可以从 User Module Catalog（用户模块目录）选择所需的组件，然后对其进行配置。用户模块窗口位
于右侧下角，如图 8 所示；通过依次选择 View > User Module Catalog 可以显示它。
图 8. User Module Catalog 窗口
该项目使用了以下各用户模块：



一个 ADC 用户模块
1.
按照下面各步骤执行操作以便放置用户模块。在 User Module Catalog 上，展开 ADCs 文件夹。
2.
右击 EzADC 并选择 Place（放置）。EzADC Configuration（EzADC 配置）窗口将会弹出。
3.
在 Configuration（配置）窗口中，选择 Double Stage Modulator（双阶调制器）并点击 OK。（该配置将使用两
个开关电容模块以获得更好的性能）
4.
在 PWMs 文件夹下，右击 PWM8，然后选择 Place（放置）。
5.
重复放置流程，将两个 PWM8 用户模块置于设计中。
6.
从 Misc Digital 文件夹右击 LCD，然后选择 Place。
两个 PWM8 用户模块
一个 LCD 用户模块
放置好所需用的户模块后，Designer 窗口将如图 9 所显示的情况。此外，已放置的用户模块会在工作区浏览器中显
示。请注意，必须将每一个已配置的用户模块命名为 ComponentName_1，其他模块以此类推。例如，EzADC 用户模
块将被命名为 EzADC_1。
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图 9. EzADC 和 PWM 用户模块在芯片编辑器中的放置（数字模块）
图 10. EzADC 用户模块在芯片编辑器中的放置（模拟模块）
7.2.3
设置 User Module 参数
在该步骤中，您将为放置在您设计中的用户模块进行配置参数。
当您在工作区浏览器或芯片编辑器中点击某个用户模块时，所选用户模块的参数窗口将在左侧弹出，这样您便可以修改
参数。
请参考框图以便设置或更改各参数。
1.
选择 EzADC_1，然后按照表 3 中显示的内容更改它的参数。各参数被更改后，该窗口将如图 11 所示。从其默认
值更改的参数将以高亮显示。
表 3. EzADC_1 用户模块参数
参数
数值
说明
名称
EzADC_1
给用户模块命名。
Data Format
无符号
如果输入仅为正向输入，那么将输出设
置为无符号数据。
Resolution
（分辨率）
14 位
设置 EzADC 的最大分辨率
Sample rate
0.007
根据分辨率设置采样率。请查看 EzADC
的用户模块数据手册。
Input
（输入）
AnalogColumn
_InputMUX_0
选择模拟输入数据总线，以便获得电源
的输入模拟电压。
Offset Compensation
使能
使能相关二次采样。
1.000
为单位放大将 PGA 增益设置为 1 。
（数据格式）
（采样率）
（补偿偏移）
Buffer Gain
（缓冲器增益）
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参数
数值
说明
Reference
VSS
设置 PGA 的参考电压以执行补偿偏移。
禁用
禁用 AGND 输出。使用该选项可生成内
部 AGND，以便将双极信号连接至
ADC。
2
设置 ADC 采样的数量，而采样后偏移会
被更正。
（参考电压）
AGND Output
（AGND 输出）
Offset Compensation
Frequency
（补偿偏移频率）
图 11. EzADC_1 用户模块参数
选择 PWM8_1，然后按照表 4 所示将其参数分别修改。更改各参数后，该窗口将如图 12 所示。请注意，此时该用户模
块应重新命名为 LED1_PWM。
表 4. LED1_PWM 用户模块参数
参数
数值
说明
名称
LED1_PWM
给用户模块分配名称。
Clock（时钟）
VC3
将 VC3 选为时钟源。
Enable（使能）
高
将 enable 设置为高电平，从而能够连续计数。
Compare Out（比较输出）
Row_0_Output_2
通过行输出总线将比较输出连接至 GPIO。
Terminal Count Out
（终端计数输出）
无
该参数是一个辅助计数器。您不需将其联结至任意行输出总线。
Period（周期）
254
设置计数器的周期。
Pulse Width（脉冲宽度）
127
设置 PWM 输出的脉冲宽度（50%占空比）。
Compare Type（比较类型）
小于或等于
给 Compare Type（比较类型）函数选择其完整范围。
Interrupt Type（中断类型）
计数终值
通过使用该选项，在计数寄存器的终端计数上触发中断。
Clock Sync（时钟同步）
Sync to SysClk（与系统时钟同步）
将时钟输入与系统时钟同步。
Invert Enable（反转使能）
正常速度
该参数确定使能输入信号的意义。
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图 12. PWM_1 用户模块参数
2.
选 择 PWM8_2 ， 然 后 按 照 图 13 所 示 的 设 置 内 容 更 改 它 的 参 数 。 请 注 意 ， 此 时 该 用 户 模 块 应 重 新 命 名 为
LED2_PWM。
图 13. PWM_2 用户模块参数
3.
选择 LCD_1 用户模块，然后按照表 5 所示内容更改它的参数。更改各参数后，该窗口将如图 14 所示。
表 5. LCD_1 用户模块参数
参数
数值
说明
名称
LCD_1
给用户模块命名
LCD Port
Port_2
该参数会使 LCD 显示模块连接至已
分配的端口
禁用
禁用条形图功能
（LCD 端口）
BarGraph
图 14. LCD 参数
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4.
从 View > Global Resources 打开 Global Resources（全局资源）窗口，配置 PWM 时钟频率的源时钟以及 ADC
输入数据范围的 Ref Mux。保留其他参数为其默认值。更改后，Global Resources 窗口将如图 15 所示。更多有关
全局资源的信息，请查看 IDE 用户指南。
图 15. 全局资源参数
7.3
路由 PWM 信号
在该选项中，用户将 PWM 信号从 PWM 用户模块路由到所选的 GPIO。 要查看 GPIO 引脚上的信号，则必须实现
PWM 信号的布线。
此外，该设计还会将两个 PWM 输出馈送至 XOR，从而实现行输出中的逻辑。两个 PWM 信号周期之差经过异或
（XOR）运算后，将形成脉冲式（心跳式）效果。
1.
将 LED1_PWM 的 CompareOut 连接至 Row_0_Output_2。
2.
将 LED2_PWM 的 CompareOut 连接至 Row_0_Output_3。
3.
通过使用自动布线将 LED1_PWM 的 CompareOut 连接到 Port_1_2。按下 Shift 键并选择 LED1_PWM 的
CompareOut 引 脚 ， 然 后 将 其 连 接 至 Port_1_2 ， 如 图 16 所 示 。 您 也 可 以 使 用 GlobleOutOdd_2 手 动 将
LED1_PWM 连接到 Port_1_2。
图 16. PWM 与行输出总线相连
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4.
点击 Row_0_Output_2 数字互连以打开配置选项，如图 17 所示。
图 17. RO0[2]数字互连视图
5.
点击 LogicTable_Select（由图中间方框指示的），然后从下拉列表中选择 A_XOR_B（如图 18 所示），然后点击
Close（关闭）。
图 18. 数字互连配置
6.
请确保数字布线图和图 19 所示的一样。如果两图匹配，则您已完成了脉冲心跳式 LED。
图 19. Designer Chip（Designer 芯片）视图
7.4
添加代码
在该步骤中，用户需要添加代码来配置所有用户模块和 GPIO，从而实现一个由软件控制其闪烁的 LED。将随后的自定
义代码添加到项目中的 main.c 文件。
1.
在 Workspace Explorer（工作区浏览器）中，在 AN75320 Folder 下面寻找 Source Files（源文件）文件夹并打
开 main.c 文件。
2.
复制以下列出的 C 代码并将其粘贴到 main.c 文件中，代替已存代码。
代码 1. 项目 1 main.c
/* part specific constants and macros */
#include <m8c.h>
/* PSoC API definitions for all User Modules */
#include "PSoCAPI.h"
/* Definitions for all input and output operation */
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#include "stdio.h"
/* Macros to set ADC parameters */
#define GAIN
1
#define MAX_ADC_COUNTS
16383
#define ADC_RANGE
5000
/* Macros to select port 1 */
#define PORT_1_3
PRT1DR
/* Variable to store the ADC result */
WORD adc_result;
/* Variable to store the measured input in millivolts */
WORD v_in;
void main(void)
{
static unsigned int index;
/* Buffer used for the long to ASCII conversion */
char LCDBuffer[17];
/* Initializes LCD to use the multi-line 4-bit interface
LCD_1_Start();
*/
/* Enable global interrupts */
M8C_EnableGInt ;
/* Set the position to print the character */
LCD_1_Position(0,0);
/* print the Hello World in the first line */
LCD_1_PrCString("Hello World!");
/* Starts the LED1_PWM and LED2_PWM, high enable input begins the Counter */
LED1_PWM_Start();
LED2_PWM_Start();
/* Initializes and starts the EzADC User Module resources */
EzADC_1_Start(EzADC_1_HIGHPOWER);
/* Starts the ADC conversion */
EzADC_1_GetSamples(0);
while(1)
{
/* Wait for the ADC result to be available */
while(!(EzADC_1_fIsDataAvailable()));
/* Read the ADC result and clear the data ready flag */
adc_result = EzADC_1_iGetDataClearFlag();
/* Calculate input voltage in mV */
v_in = (DWORD)adc_result*ADC_RANGE / MAX_ADC_COUNTS / GAIN;
/* Convert the input voltage to an ascii string */
csprintf(LCDBuffer, "ADC INPUT:%4dmV", v_in);
/* Set the position to print the character */
LCD_1_Position(1,0);
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/* print the voltage in the second line */
LCD_1_PrString(LCDBuffer);
/* Toggle the pin 1[3]*/
PORT_1_3 ^= 0x08;
/* Give some delay to view toggling effect*/
for(index = 0; index < 22000; index++);
}
}
3.
7.5
添加该项目附带的 local.mk 文件以便使能 ADC 浮点功能。更多有关该函数的信息，请查看 local.mk 文件。
配置引脚分布
在该步骤中，用户要为引脚配置 GPIO 驱动模式，从而能够驱动 LED。为从 Pinout（引脚分布）视图所选的器件配置
引脚分布。（View（视图） > Pinout（引脚分布））。Pinout 屏幕将显示在工作区的左下方。
1.
在 Pinout 视图上，展开 P0[1]、P0[5]、P1[2]和 P1[3]。按照图 20 配置各引脚。
图 20. 引脚配置
7.6
构建和编程
在该步骤中，请将 MiniProg1 器件连接到您的电脑上，并使用构建项目编程 PSoC 器件。
1.
选择 Build（构建） > Generate/Build ‘AN75320’ Project（生成/构建‘AN75320’项目）或按下 F6 按键。
（请参考图 21）。
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图 21. 构建与生成选项
2.
输出窗口将显示构建状态，其中具有 RAM/闪存用法以及错误和警告数量，如图 22 中所示。
图 22. Output 窗口
3.
将 MiniProg 1 / MiniProg 3 连接至您的电脑。
4.
将 MiniProg 1 / MiniProg 3 连接至电路板上的编程接头。更多详细信息，请参考设置 CY3210-PSoCEval1 电路板
一节中的步骤 4。
5.
选择 Program（编程） > Program Part（编程器件）（如图 23 所示）。Program Part（编程器件）窗口将如
图 24 所示。
图 23. 编程器件选项
6.
在 Program Part 窗口上，请执行以下各操作：
a)
点击 Connect（连接）按键（Port Selection 字段旁边），连接至器件。
b)
如果 MiniProg 给器件供电，Acquire Mode（获取模式）将被设置为 Power Cycle（电源循环），通过循
环电源，MiniProg 可以获取器件。这是默认选项。对于该项目，请使用该默认选项。
c)
如果器件通过外部供电，Acquire Mode（获取模式）将被设置为 Reset（复位），MiniProg 只能通过复
位获取器件。
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7.
点击 Program（编程）按键，对器件进行编程，如图 24 所示。
图 24. 编程状态
8.
7.7
当完成编程操作时，按下 Power 按键，对器件进行切换。此时，编程器会为电路板供电。观察一个 LED 闪烁，另
一个 LED 淡入淡出。
设置 CY3210-PSoCEval1 电路板
本演示与 CY3210-PSoCEval1 硬件兼容。有关此套件的更多信息，请访问
http://www.cypress.com/documentation/development-kitsboards/cy3210-psoceval1 网站。
图 25. CY3210-PSoCEval1 套件图示
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按以下步骤对 CY3210-PSoCEval1 套件进行配置和编程。请注意，此套件需要使用编程器件，例如 MiniProg 或 ICECube。
1.
演示板上未连接线缆时，请确保未接通 J1、J2 和 J3。
2.
用一根导线将 P0[1]连接至 VR，将 P1[2]连接至 LED1，用另一根导线将 P1[3]连接至 LED2 （如图 26 所示）。
图 26. CY3210-PSoCEval1 引脚连接
3.
确保电路板上的当前器件为 CY8C29466-24PXI。
4.
要想为电路板供电，那么将 MiniProg 1 / MiniProg 3 连接至编程接头（J11）。另外，将 12 V 直流电源连接至套
件中的 J10。也可以将一节 9 V 电池与 J12 相连。此外，还需将一个编程器件连接至 J11。使用外部电源或电池
时，使用复位编程模式。电路板连接情况如图 27 所示。
图 27. 电源与程序连接
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7.8
设置 CY8CKIT-001 电路板
在使用 CY8C29x66 处理器模块时，本演示可与 CY8CKIT-001 硬件兼容。有关此套件的更多信息，请访问
http://www.cypress.com/?rID=37464 网站。
按以下步骤对 CY8CKIT-001 套件进行配置和编程。请注意，此套件需要使用编程器件，例如 MiniProg 或 ICE-Cube。
此外，使用 ICE-Cube 时，此套件支持片上调试。
图 28. CY8CKIT-001 套件图示
1.
在演示板未连接线缆的情况下，按表 6 所示设置以下跳线器，以配置开发板：
表 6. 跳线器设置
跳线器
2.
Setting（设置）
VDD 选择（SW3）
5 V（上方位置）
5 V 源（J8）
VREG（上方两个引脚）
VDD 数字（J7）
VDD（上方两个引脚）
VDD 模拟（J6）
VDD（上方两个引脚）
LCD 电源（J12）
ON（下方两个引脚）
VDDIO 选择（J2-J5）
VDD（上左方两个引脚）
一根导线将 P0[1]连接至 VR，将 P1[2]连接至 LED1， 用另一根导线将 P1[3]连接至 LED2（如图 29 所示）。
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图 29. 引脚连接图
3.
将 MiniProg 或 ICE 等编程器件连接至 PSoC 1 处理器模块上的 J5。
4.
之后，通过使用编程器的电源或 12 V 直流电源或一节 9 V 电池，将电源连接至电路板。使用外部电源或电池时，
必须使用复位编程模式。查看图 30 以便了解电路板上的连接情况。
图 30. 电源与程序连接
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无论使用哪套开发套件来测试此应用，您都会看到：
8
5.
LCD 显示“Hello World”和“ADC INPUT:----mV”
6.
一个 LED 快速闪烁。
7.
另一个 LED 闪烁速度则非常缓慢，亮度逐渐增加和减弱。
总结
本应用笔记展示了 PSoC 1 架构以及开发套件。本应用笔记描述了启动 PSoC 1 项目所需的工具。PSoC 1 是一个真正
的可编程嵌入式片上系统，它在单芯片上集成了可配置的模拟和数字外设功能、存储器和 M8C 微控制器。
此外，本应用笔记还向您提供了全部资源列表，用以加快深入学习有关 PSoC 1 的知识。
有关其中所涉任何主题的更多信息，请参阅相应的链接或参考，也可以访问 http://www.cypress.com/products/psoc-1
9
相关应用笔记
该应用笔记介绍了 PSoC 1 的基本信息。有关更多信息和特殊主题的相关项目，请参考应用手册中介绍的内容。
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AN54181 — PSoC 3 入门

AN79953 — PSoC 4 入门

AN77759 — PSoC 5LP 入门
模拟





AN2219 — PSoC® 1 选择模拟接地和参考
AN74170 — PSoC 1 模拟结构和通过 PSoC Designer 进行的配置
AN13666 — 将 PSoC® 1 模拟缓冲输出驱动至轨
AN2096 — PSoC® 1 — 使用 ADCINC 模数转换器
开关电容模块




AN2041 — 了解 PSoC 1 开关电容模拟模块
AN2168 — PSoC 1 了解开关电容滤波器
AN16833 — 使用 PSoC®开关电容模块进行信号复用
GPIO


AN2094 — PSoC® 1 — GPIO 入门
编程


AN44168 — 使用外部微控制器（HSSP）的 PSoC® 1 器件编程
数字


AN2141 — PSoC® 1 脉冲自由 PWM
闪存

AN2015 — PSoC 1 读取和写入闪存以及 E2PROM
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I2C


SPI


AN51234 — PSoC® 1 SPI 入门
睡眠模式


AN50987 — PSoC 1 I2C 入门
AN47310 — 使用睡眠模式节省 PSoC® 1 功耗
LCD


AN56384 — PSoC® 1 段 LCD 直接驱动
AN2152 — PSoC® 1 图形 LCD 和 PSoC®接口
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问赛普拉斯所在地。
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PSoC®解决方案
汽车级产品
cypress.com/go/automotive
psoc.cypress.com/solutions
时钟与缓冲器
cypress.com/go/clocks
PSoC 1 | PSoC 3 | PSoC 4 | PSoC 5LP
接口
cypress.com/go/interface
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存储器
cypress.com/go/memory
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无线/射频
cypress.com/go/wireless
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